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• Portable Document Format files:
• A self-contained file that looks the same everywhere, on any device.
• Created by Adobe in 1993.
• Made an open ISO standard and released public patent (ISO 32000-1) in 2008

What is a PDF?

Copyright © 2022 by Affinity Consulting. All rights reserved.

What Can You Make Into a PDF?
• Electronic Files (Word, Excel, Pages, Google Docs, etc.)
• Digital Images (TIFF, JPG, PNG)
• Paper Documents (via a scanner device or app)
• Webpages
• Email
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Types of PDFs
• Digital-Native (“Text”) PDFs
• Image-Only PDFs (Scanned PDFs)
• Searchable PDFs (Image + Text)
• Digital-native PDFs are searchable by their nature.
• Image-only PDFs can be made searchable via OCR (Optical Character Recognition)
• PDF/A (archival PDF; popular for court filings)
• Combined PDFs (Binder or PDF Portfolio)

• Created directly from original 
source, like Word

• Is text searchable
• Text is 100% accurate to 

original source
• Highest quality
• Smallest size

• Just an image of the original 
source

• Is not text-searchable
• Default type of PDF created by 

scanners.

• Has a layer of search text 
behind image of original 
source.

• Is text-searchable
• Text might not be 100% 

accurate
• Indispensable for law firms.

Digital-Native Image-Only Searchable
(image + text)

Types of PDFs
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Types of PDFs

Copyright © 2022 by Affinity Consulting. All rights reserved.

More About PDF/A
• Designed for long-term storage.
• Many courts require them.
• Must be “self-contained”.
• Nothing pretty, fancy, noisy, or external to the PDF.
• No embedded font.
• No encryption.
• No audio
• No video
• No links to external material like websites or anything outside of the PDF document.
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ACROBAT’S 
INTERFACE

Read about it here.

Try it on Acrobat for Windows
(View > Enable new Acrobat)

Can switch between interfaces

New Interface
Coming

https://helpx.adobe.com/acrobat/using/new-acrobat-experience.html
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Acrobat Interface Terms
• Main Areas: Home, Tools, Document
• 4 Main Toolbar Areas
• 1 Secondary Toolbar
• Basic Acrobat Usage:

1. Select Tool
2. Secondary Toolbar appears
3. Perform action
4. Close Secondary Toolbar
5. Rince and repeat for next action
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Selecting and Using Acrobat Tools

Copyright © 2022 by Affinity Consulting. All rights reserved.

Customizing
“I hate tabs.  

I want each document in its own window.”
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Customizing
“I want the same zoom setting each time I open Acrobat.”

Copyright © 2022 by Affinity Consulting. All rights reserved.

Customizing
“The screen is too busy. How do I hide some of this.”
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Customizing
“I messed up my toolbars.”

Copyright © 2022 by Affinity Consulting. All rights reserved.

Recommended Customizations
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Customizing the Tools Pane

Click into the Tools area to configure the Tools Pane.  

If you are in a document tab, you will need to right click on the 
tool to change.

Copyright © 2022 by Affinity Consulting. All rights reserved.

Customizing the Tools Pane
Note: The same feature might be in more than one tool.
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Custom Tools

VIEW & NAVIGATION
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Viewing & Navigating PDFs

• Zooming
• Read Mode
• Full Screen Mode
• Window Menu
• Split
• Spreadsheet Split
• New Window
• Cascade/Tile

• Drag & Drop Tabs
• Bookmark & Link 

Navigation
• Go to a Page
• Read Out Loud

Copyright © 2022 by Affinity Consulting. All rights reserved.

Zoom

• + and – buttons or the zoom 
control

• CTRL + mouse wheel
• Miscellaneous tools (Marquee 

Zoom)
• View -> Zoom

Remember you can set your 
preferred zoom in the options 
(prior slide).
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Read Mode

CTRL + H (hide everything else 
in the window)

Read Mode hides all toolbars and side 
panes and adds a “floating” navigation 
bar near the bottom of the screen.
Press CTRL + H or Escape or click the 
Read Mode button to leave Read Mode.

Copyright © 2022 by Affinity Consulting. All rights reserved.

Full Screen View

CTRL + L (look at the document, 
and nothing else)

Full Screen Mode takes over the entire 
screen and displays the document one 
page at a time.
Press CTRL+L or Escape to leave Full 
Screen Mode.
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Full Screen Mode Options

Can specify which monitor will 
display Full Screen Mode.

Copyright © 2022 by Affinity Consulting. All rights reserved.

Full Screen Mode Options

Can specify which monitor will 
display Full Screen Mode.
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Go to a Particular Page

Copyright © 2022 by Affinity Consulting. All rights reserved.

Read Out Loud
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Find & Advanced Search

• Find
• Replace
• Advanced Search
• Indexing

Copyright © 2022 by Affinity Consulting. All rights reserved.

Find

Use Find to search through one 
PDF.

Edit->Find 
Magnifying Glass Icon
CTRL+F

CTRL+G = Find Next 
(Go to next)

CTRL+SHIFT+G = Find Previous
(Go to previous)
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Replace

Replace only works with a “True PDF” or a PDF that is 
searchable with editable text.

There is no “Replace All” feature.

When you activate the Replace feature, Acrobat will 
automatically activate the Edit tool.

Copyright © 2022 by Affinity Consulting. All rights reserved.

Advanced Search

Binoculars Icon, Edit->Advanced Search or CTRL+SHIFT+F.
Note the “Show More Options” link at the bottom of the window.
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Advanced Search

Search current document
Search a folder of PDFs
Search PDF Index

Returns a list of search hits

Search results are links to 
location in the document(s)

Copyright © 2022 by Affinity Consulting. All rights reserved.

Indexing

To add a searchable index to a PDF, select the Index tool, 
click “Manage Embedded Index” and embed the index.
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CREATE PDFS

Copyright © 2022 by Affinity Consulting. All rights reserved.

Creating PDFs

• Create from Word
• Create from Outlook
• Create from Scanner
• Create from Multiple 

Documents
• Create Single PDF from Multiple 

Documents
• Use Organize tool to combine
• Use Page Thumbnails to combine

• Page Numbering
• Page Labels
• Watermarks
• Create from Clipboard
• Create from Web Page
• Create from Printing
• PDF Portfolios
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Creating PDFs from Word

Native Word Interface (without Acrobat)

Copyright © 2022 by Affinity Consulting. All rights reserved.

Creating PDFs from Word

Email from native Word Interface (without Acrobat)
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Creating PDFs from Word

Acrobat

Copyright © 2022 by Affinity Consulting. All rights reserved.

Creating PDFs from Outlook
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Creating PDFs from Scanner
Scanner just takes a “picture” of the document.

Use the Enhance Scan tool to OCR, deskew and enhance the scan.

Copyright © 2022 by Affinity Consulting. All rights reserved.

Creating PDF from Multiple Documents
File->Create->Combine Files into a Single PDF

Create Tool -> Multiple Files -> Combine
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Creating PDF from Multiple Documents

Add bookmarks for TOC of documents.

Adobe will automatically convert documents to PDF.

If you use Organize or Page Thumbnails to combine 
documents, then you will have to manually insert the 
bookmarks.

Copyright © 2022 by Affinity Consulting. All rights reserved.

Add Page Numbering
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Page Labels

Copyright © 2022 by Affinity Consulting. All rights reserved.

Add Watermark
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Creating PDFs (Miscellaneous)

• Create from clipboard

• Create from a web page

• Create by printing

Copyright © 2022 by Affinity Consulting. All rights reserved.

PDF Portfolios
Main difference with a Portfolio is that it contains documents other than PDFs.
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PDF Portfolios
Change the layout from the view menu.

MANIPULATE PDFS
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Manipulating PDFs

• Organize Tool
• Thumbnails
• Split Document
• Shrink Document
• Convert Document
• Editing PDFs
• Securing PDFs
• Comparing PDFs

Copyright © 2022 by Affinity Consulting. All rights reserved.

Organize Tool
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Page Thumbnails

Copyright © 2022 by Affinity Consulting. All rights reserved.

Split Documents
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Shrink Documents

Copyright © 2022 by Affinity Consulting. All rights reserved.

Convert Documents
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EDITING PDFS

Copyright © 2022 by Affinity Consulting. All rights reserved.

Editing PDFs

• Edit Tool
• Scanned PDFs must be recognized for editable text
• “Add Text” (Typewriter Tool) can add text to any PDF
• Snapshot Tool can copy image of PDF
• PDF Security
• Comparing PDFs
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Edit Tool

Copyright © 2022 by Affinity Consulting. All rights reserved.

PDF Security
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Compare PDFs

Copyright © 2022 by Affinity Consulting. All rights reserved.

Bates Numbering (1)
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Bates Numbering (2)

Copyright © 2022 by Affinity Consulting. All rights reserved.

Redacting PDFs

You must use the Redaction Tool.

DO NOT DRAW BLACK BOXES WITH THE 
COMMENT TOOLS!
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Redacting PDFs

Copyright © 2022 by Affinity Consulting. All rights reserved.

Redaction – Manual

1. Save your document with a different name
2. Mark areas for Redaction
3. Apply Redactions
4. Save
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Redaction – Search and Redact

Copyright © 2022 by Affinity Consulting. All rights reserved.

Comments

• Comments (Comment Tool)
• Shared Review (Send for Comments Tool)
• Email 
• Shared Server like SharePoint
• Enable Reader for Commenting
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Signature Stamp

• Stamp Tool
• Signature Tool

Copyright © 2022 by Affinity Consulting. All rights reserved.

Bookmarks

• Adding Bookmarks
• Organizing Bookmarks
• Navigating Bookmarks
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Forms

• Creating Forms
• Filling Forms
• Making Forms Reader-Enabled

Copyright © 2022 by Affinity Consulting. All rights reserved.

Review

• Interface
• Main Window
• Customizing

• Viewing PDFs
• Manipulating Pages
• Rotate Pages vs Rotate View
• Page Numbers vs Page Labels

• Combining PDFs
• Shrinking and Splitting
• Security

• OCR
• Typewriter Tool
• Edit Text vs Add text
• Snapshot Tool
• PDF Portfolios
• Comments
• Electronic “Stamp” Signature
• Bates Numbering
• Redacting
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THANK YOU!
Jeffrey 
Schoenberger jschoenberger@affinityconsulting.com

mailto:jschoenberger@affinityconsulting.com?subject=Webinar%20-%20Adobe%20Acrobat
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ADOBE ACROBAT 
FOR LEGAL PROFESSIONALS 

PERSONAL LICENSE 

©2023 Affinity Consulting Group LLC 

ALL RIGHTS RESERVED. No part of this work covered by the copyright herein may be reproduced or distributed 
in any form or by any means, except as permitted by U.S. copyright law, without the prior written permission 
of the copyright owner. 

Adobe and the Acrobat logo are either registered trademarks or trademarks of Adobe in the United States 
and/or other countries. Affinity Consulting Group LLC is an independent entity from Adobe and is not affiliated 
with Adobe in any manner. 

The materials in this book were written using Adobe Acrobat Pro DC and all steps and instructions were tested 
prior to the publication date. As Adobe continuously updates Acrobat DC, your software experience may vary 
slightly from what is seen in this manual. 

For training or technology assistance, contact us at Affinity Consulting Group LLC - 614.602.5561 or 
info@affinityconsulting.com. For permission to use materials from this text or product, submit all requests via 
email to info@affinityconsulting.com. 

This is for your personal use only, you may not distribute, modify, or copy the materials, except for archival or 
backup purposes, without express permission of the copyright owner. 

Version 3.02  
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MEET OUR TEAM OF ACROBAT EXPERTS 
Meet our team of Acrobat experts who have co-authored this manual. 

BARRON HENLEY 
Most people wouldn’t relish the idea of spending a day in a conference 
room, teaching Adobe Acrobat. Barron is not most people. There are few 
things Barron enjoys more than teaching all-day software training classes. 

As an attorney, he understands how challenging it is to practice law 
without the proper training on the technology tools. When Barron isn't 
training he focuses on automating documents and teaching CLE classes 
for attorneys across North America. 

 
 
 
 

 

PAUL UNGER  
Paul's passion is coaching lawyers on managing time, distractions, tasks, 
emails, and documents efficiently. As the author of Tame the Digital Chaos 
– A Lawyer’s Guide to Time, Task, Email and Distraction Management, Paul 
is truly an expert on the topic. 

Paul's expertise is well-founded from his time practicing law. When Paul 
isn't coaching lawyers, he teaches CLE classes for attorneys across North 
America. 

 
 
 
 

DANIELLE DAVISROE  
Passionate about remote learning, Danielle is the force behind Affinity's 
membership training program, Affinity Insight. Danielle focuses on 
creating easily accessible training materials and webinars tailored to meet 
each organization's needs. From one-on-one training to organization-wide 
training plans, Danielle has her clients covered.  

When Danielle isn't providing remote training, she focuses on teaching 
CLE via webinar and providing legal organizations with the advice they 
need to run smoothly. With a background practicing law at a boutique 
firm, Danielle understands the challenges that legal professionals face 
every day. 
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CHAPTER 1 
THE INTERFACE 

Overview 

 
FIGURE 1-1 

The Home button opens the Home Screen, hiding the Document Screen and most other 
controls. See page 4 below. 

The Tools button opens the Tools Screen, giving you access all of Acrobat’s tools. The Tools Screen 
hides the Document Screen and most other controls. See page 4 below. 

The Document tab opens the named document in the Document Screen.  

The Common Controls toolbar includes buttons for commonly used commands, such as saving, 
printing, and navigating between pages. It is visible when the Document Screen is open. 

The Quick Tools toolbar is a customizable toolbar that gives you one click access to the tools you 
use most often. It is visible when the Document Screen is open. See page 8 below for instructions 
on how to show, hide, and customize Quick Tools. 

Recent Tools toolbar gives you one click access to your most recently used tools. It is visible 
when the Document Screen is open. See page 11 below for instructions on how to show or hide 
recent tools.  
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The Navigation Pane provides quick navigation using features such as thumbnails, bookmarks, 
and attachments. See page 5 below. 

The Page Controls Toolbar includes buttons for selecting text, zoom control, and other view 
settings. See page 7 below for instructions on how to dock it at the top of the screen. 

The Tools Pane is a customizable list of toolbars that provides one click access. See page 6 below. 

Home Screen 
The Home Screen opens when Acrobat is first opened. It can also be access from the Document 
Screen by clicking on the Home Screen button. From the Home Screen you can easily access 
recently used documents and check the status of documents sent for digital signatures with 
Acrobat Sign. 

 
FIGURE 1-2 

Tools Screen 
The tools screen, accessed from the Document Screen by clicking on the Tools button, provides 
access to all of Acrobat’s tools, organized into toolbars. Click on the name of a toolbar to open it. 

Searching for Tools 
The easiest way to navigate the Tools Screen is to search for tools. Click in the Search tools box at 
the top and type your search term. The list of toolbars will automatically be filtered to the relevant 
options. 
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FIGURE 1-3 

Navigation Pane 
The Navigation Pane provides quick navigation using features such as thumbnails, bookmarks, 
and attachments. 

If the Navigation Pane is hidden, click on the arrow on the left-hand side of the screen to expand 
the Navigation Pane. 

 
FIGURE 1-4 
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Tools Pane 
The Tools Pane gives you one click access to toolbars. The Tools Pane can be minimized to show 
icons for each toolbar or expanded to show the icon and the toolbar name. 

To expand the Tools Pane, click on the arrow on the right-hand side. 

 
FIGURE 1-5 

See Chapter 2 for instructions on how to customize the Tools Pane. 
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CHAPTER 2 
CUSTOMIZING THE 

INTERFACE 
Dock the Page Controls Toolbar 

To prevent the Page Controls toolbar from disappearing, click on the  button on the Page 
Controls toolbar to dock it at the top of the screen. 

 
FIGURE 2-1 
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Quick Tools 
Showing/Hiding Quick Tools 

To show or hide the Quick Tools, right-click in the toolbar, and select either Hide Quick Tools or 
Show Quick Tools. 

 
FIGURE 2-2 

Customizing Quick Tools 
To customize the Quick Tools, right-click on Quick Tools, and select Customize Quick Tools… 

 
FIGURE 2-3 
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Adding Tools 

To add tools to Quick Tools, expand the sections under Choose tools to add to clicking on the 
section name. 

 
FIGURE 2-4 
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Select the tool to add and click on the up arrow to add it to Quick Tools. 

 
FIGURE 2-5 
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Reordering Tools 

To reorder tools within Quick Tools, select the tool to move and click on the right or left arrow. 

 
FIGURE 2-6 

Removing Tools 

To remove a tool from Quick Tools, select the tool to delete and click on the trashcan. 

 
FIGURE 2-7 

Recent Tools 
To show or hide the Recent Tools, right-click in the toolbar, and select either Hide Recently Used 
Tools or Show Recently Used Tools. 

 
FIGURE 2-8 
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Navigation Pane 
To customize which buttons appear in the Navigation pane, right-click on the Navigation Pane 
and click on buttons to toggle them on or off. 

 
FIGURE 2-9 

Tools Pane 
To customize the Tools Pane, open the Tools Screen by clicking the Tools button.  
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Adding Tools 

To add tools to the Tools Pane, click on the Add button. 

 
FIGURE 2-10 
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Reordering Tools 

To reorder tools, drag-and-drop them on the right-hand side. 

 
FIGURE 2-11 
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Removing Tools 

To remove a tool, click on the dropdown arrow next to Open, and select Remove Shortcut. 

 
FIGURE 2-12 
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Toolbars 
To customize which tools appear in a particular toolbar: 

1. Open the toolbar. 

2. Right-click on the toolbar and select Customize… Tools. 

 
FIGURE 2-13 

3. Select the tools to be shown and click on the up arrow to show them. 

 
FIGURE 2-14 
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4. To remove tools from the toolbar, select it and the trashcan. 

 
FIGURE 2-15 

5. To reorder tools, select the tool to be moved and the left or right arrow. 

 
FIGURE 2-16 
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CHAPTER 3 
VIEWING PDFS 

In addition to the main screen, Acrobat offers several other modes to view a PDF: 

Opening PDFs in New Windows 
By default, PDFs are opened in tabs within the same window. 

 
FIGURE 3-1 
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To open PDF side-by-side, drag-and-drop one of the tabs away from the other ones. That PDF 
will open in a new window. 

 
FIGURE 3-2 

Document Tab Settings 

If you’d prefer for PDFs to open in their own window every time, go to the Edit menu, and click 
on Preferences. Click on General on the left-hand side. Uncheck the box next to Open 
documents as new tabs in the same window. Click OK, and restart Acrobat. 

 
FIGURE 3-3 
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Read Mode 
Read Mode hides all the controls, except for the menu, on the screen and fills the window with 
the PDF. Press the Escape key to return to the main screen or toggle back and forth with 
CTRL + H. 

Full Screen Mode 
Full Screen mode fills the entire computer screen with the PDF. This is often helpful to use during 
presentations, so you can hide busy and distracting toolbars. Press the Escape key to return to 
the main screen, or toggle back and forth with CTRL + L. This is important to remember with 
Acrobat DC because if you put it in full screen mode, the ONLY way to get it out of that mode is 
Ctrl + L. 

To zoom in and out while in full screen mode, place your mouse on the center-point, and then 
hold your Ctrl key and use your mouse scroll wheel to zoom in and out.  
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Read Out Loud 
If the PDF is text based or the text has been recognized, Acrobat can read the PDF using a built-
in speech synthesizer. To have Acrobat read a PDF: 

1. Click View  Read Out Loud  Activate Read Out Loud. 

2. Click View  Read Out Loud  Read Page or Read To End of Document. 

 
FIGURE 3-4 
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CHAPTER 4 
MAKING PDFS TEXT 

SEARCHABLE 
Optical Character Recognition 

Many copiers/scanners create image-only PDFs. You cannot search for particular words inside 
the PDF when it is image only. The process of making image only PDFs text searchable is called 
Optical Character Recognition (“OCR”). 

To OCR a PDF: 

1. Open the Scan & OCR toolbar. 

2. Click on Recognize Text. 

3. Select In This File. 

 
FIGURE 4-1 

4. Click on . 
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5. For Output, select Editable Text and Images. See page 25 for an explanation of why this 
is so important. 

 
FIGURE 4-2 

6. Click on Recognize Text. 

 
FIGURE 4-3 

Batch Processing 
You can OCR multiple PDF files at once. 

1. Open the Scan & OCR toolbar. 

2. Click on Recognize Text. 

3. Select In Multiple Files. 

 
FIGURE 4-4 
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4. Click on Add Files… to select the files to be OCRed. 

 
FIGURE 4-5 
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5. Choose where to save the new files, how to name them, and whether to overwrite existing 
files. 

 
FIGURE 4-6 

6. Click OK. 

7. For Output, select Editable Text and Images. 

Importance of Editable Text and Images 
You can improve the quality of scanned documents and reduce the PDF file size by turning on 
Editable Text and Images in Acrobat DC when converting image-only PDFs to text-searchable 
PDFs.  

To appreciate what Editable Text and Images can do, below is a screen shot of some text scanned 
at 300 dpi in an image-only PDF zoomed in 1,000%. 

 
FIGURE 4-7 
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Here is the same text after the PDF was made searchable using Editable Text and Images. As you 
can see, the difference is dramatic. 

 
FIGURE 4-8 
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CHAPTER 5 
ANNOTATING PDFS 

You use the Comment and Edit PDF tools to annotate PDFs. Annotations added from the 
Comment tools show in the Comments pane and be exported in a comments summary. 

Add Text 
The Add Text tool, found in the Edit PDF tools (found on the Tool screen - see page 4), allows 
you to type anywhere on a PDF simply by clicking and typing. 

 
FIGURE 5-1 

To change font or paragraph properties of the text, use the Edit PDF pane on the right-hand 
side. 

 
FIGURE 5-2 
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Text Selection 
If you select text, you can highlight it, underline it, strike through it, copy it, or edit from the 
floating menu that appears. 

 
FIGURE 5-3 

Comments Tools 
The Comment tools, found on the Tools screen (see page 4), allow you to annotate the PDF with: 

• Sticky notes 

• Highlighting 

• Underlining 

• Strike throughs 

• Notes to replace text 

• Insertions 

• Text comments 

• Text boxes 

• Free hand drawings 

• Stamps 

• Attachments 

• Shapes 

 
FIGURE 5-4  
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Comments Pane 
Annotations added with the Comment tools appear in the Comments pane. 

 
FIGURE 5-5 

From the Comments pane, you can post comments, reply to comments, delete comments, 
change comments properties, or mark comments as completed. 

Posting Comments 

When you post a comment, you can mention others by email address in the comment using @. 
When others are mentioned, the PDF will be saved to Acrobat’s Document Cloud and they will 
be provided access to it. You are not required to mention anyone to post a comment. Posting 
comments is required for replying to comments (see below). 

 
FIGURE 5-6 
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Replying to Comments 

You can reply to posted comments by clicking on the comment in the Comments pane, and 
adding your reply in the Add a reply… box. Unposted comments cannot be replied to. Click Post 
after finishing your reply. 

You can also mention others by email address in the reply using @. When others are mentioned, 
the PDF will be saved to Acrobat’s Document Cloud and they will be provided access to it.  

 
FIGURE 5-7 

Deleting Comments 

To delete a comment, click on the … button to the top-right of the comment in the Comments 
pane, and select Delete. 

 
FIGURE 5-8 
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Changing Comment Properties 

To change comment properties, such as colors, click on the … button to the top-right of the 
comment in the Comments pane, and select Properties. 

 
FIGURE 5-9 

Marking Comments as Completed 

To change the status of a comment, click on the … button to the top-right of the comment in 
the Comments pane, and click on Set Status, and select the desired status. 

 
FIGURE 5-10 

Text Comments 
Text comments allow you to add text to a PDF, similarly to the Add Text tool (see page 27). Text 
comments, however, appear in the Comments pane and appear in the Comments summary. 

 
FIGURE 5-11 
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You can change the font, font size, font color, and line spacing of text comments. If you want 
more formatting options, consider the Add Text tool (see page 27). To change the formatting of 
a Text Comment, click on the Aa button. 

 
FIGURE 5-12 

Text Boxes 
Text boxes allow you to add text inside a box anywhere on your PDF. 

 
FIGURE 5-13 

With text boxes, you can change the font, font size, font color, alignment, and make the text bold, 
italics, underlined, stricken through, subscript, or superscript using the Aa button. 

 
FIGURE 5-14 

To change the box properties, such as the outline or fill color, click on the … button to the top-
right of the comment in the Comments pane, and select Properties. 

 
FIGURE 5-15 
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Attach files 
You can insert other files (such as a Word file) into a PDF. It appears as an icon and if you double 
click it, the original file will open in its original format (it is not converted to PDF). 

You can record voice messages and attach them to PDF using Attach Files. 

 
FIGURE 5-16 

Printing Comments 
When you print a PDF with annotations, you need to do two things to make sure they all appear 
on the printed version. First, you need to go into Acrobat’s Preferences (Edit menu  
Preferences), then click on Commenting  check Print notes and pop-ups. 

 
FIGURE 5-17 
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Then, when printing, under Comments & Forms, select Document and Markups to print the 
comments. 

 
FIGURE 5-18 
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Comment Summaries 
To create a comment summary, click on the … button in the top right-hand corner of the 
Comment pane and select Create Comment Summary… 

 
FIGURE 5-19 
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Filtering Annotations 
You can filter or display the annotations by author, comment type, or color Click on the filter 
button in the Comments pane: 

 
FIGURE 5-20 

Floating Toolbar Options 
When the Comments tools are closed, you can then change comment properties using the 
floating toolbar. To use the floating toolbar, click on the annotation and then select click on the 
colored circle. 

 
FIGURE 5-21 
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CHAPTER 6 
REDACTION 

Importance of Proper Redaction 
The importance of properly redacting a document cannot be understated. Using the Redaction 
tools, as described in this chapter, is the only proper way to redact information. Any other 
method may result in the disclosure of redacted information. One merely needs to read the news 
to see prominent attorneys in trouble for improperly redacting documents. 

Step 1: Save a Copy First 
Redactions cannot be undone unless the PDF is closed without saving changes. Therefore, 
you want to start by saving a copy of your PDF. Keep the original intact and redact the 
information from the copy. 

Step 2: Open the Redaction Toolbar 
Start by opening the Redact toolbar (see page 4). 

 
FIGURE 6-1 

Set 3: Set the Redaction Properties 
To change the redaction to any color other than black or use overlay text, you need to change 
the Redaction Properties. Click on dropdown arrow next to Redact Text & Images and select 
Properties. Once redaction properties are set, the PDF is ready for redaction. 

 
FIGURE 6-2 

Step 4: Mark for Redaction 
Once the properties are set, mark the information to be redacted by manually selected the 
information, searching for the information, or redacting whole pages. 

Manually Redact Text and Images 
1. Click on the Redact Text & Images button. 
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2. Select the text/image to be redacted. 

3. Continue to select text and images until all information to be redacted is marked. 

Search and Redact 

Warning About Searching to Redact 

The Search and Redact function will not catch misspellings or text not explicitly searched for. 
When using the Search and Redact function, it is critical that one review the PDF to ensure 
that all information has been properly selected and marked for redaction. To search for text 
and mark it for redaction: 

1. Click on the Redact Text & Images dropdown arrow  Find Text & Redact. 

 
FIGURE 6-3 
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2. Perform a search for the desired text, phrase or pattern. 

 
FIGURE 6-4 
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3. Click on the Search & Remove Text button. 

4. Select the results you would like to mark by checking the boxes to the left of the result list. 

5. Then select Mark for Redaction.  

Redact Whole Pages 
Select Redact Text & Images dropdown arrow  Redact Pages. 

 
FIGURE 6-5 

Step 5: Apply Redactions 
Once the redactions are marked, click on the Apply button to apply the redactions.  

 
FIGURE 6-6 

Do Not Skip Applying Redactions 
Once redacted, you will not be able to undo the redaction (unless you close the PDF without 
saving). Be sure to save the redacted PDF. If you do not apply redactions, then any information 
marked for redaction in Step 4 remains easily readable. 
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CHAPTER 7 
ELIMINATING METADATA 

PDFs, just like word processing documents, have metadata. To remove metadata from a PDF: 

1. Open the Redact toolbars (see page 4). 

2. Click on Sanitize Document. 

 
FIGURE 7-1 

3. Click on the Click Here link to selectively remove metadata. 

 
FIGURE 7-2 
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4. Check the boxes next to the information you want to remove. 

 
FIGURE 7-3 

5. Click on the Remove button. 
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